
Aula 9 3 AR Foundation: Unificando ARKit e 
ARCore
No dinâmico universo da Realidade Aumentada (RA), a inovação é constante, mas também traz consigo um desafio 
persistente: a fragmentação. Desenvolver aplicações de RA que funcionem perfeitamente tanto em dispositivos 
iOS quanto Android significa, muitas vezes, lidar com dois ecossistemas distintos 3 o ARKit da Apple e o ARCore do 
Google. Cada um possui suas particularidades, suas APIs e suas abordagens para entender o mundo real. Para um 
desenvolvedor, isso pode se traduzir em retrabalho, complexidade e um gargalo na produtividade.

Imagine a frustração de criar uma experiência imersiva incrível, apenas para descobrir que você precisa reescrever 
grande parte do código para alcançar um público mais amplo. É nesse cenário que o AR Foundation da Unity 
emerge como uma solução poderosa e elegante. Ele atua como uma ponte, uma camada de abstração que permite 
aos desenvolvedores escreverem um único código que se adapta automaticamente às capacidades de cada 
plataforma subjacente.

Nesta aula, vamos desvendar o AR Foundation, compreendendo como ele simplifica o desenvolvimento 
multiplataforma e nos prepara para a era da Computação Espacial. Nosso objetivo é que, ao final, você seja capaz 
de entender sua arquitetura, identificar seus componentes essenciais e configurar um projeto Unity do zero para 
criar sua primeira aplicação de RA básica. Prepare-se para unificar o mundo da Realidade Aumentada e expandir 
suas possibilidades de criação.



O Desafio da Fragmentação na AR e a 
Promessa do AR Foundation
O desenvolvimento de Realidade Aumentada (RA) é, por natureza, uma área que exige a interação profunda com o 
hardware e o software dos dispositivos. Cada smartphone, tablet ou óculos de RA possui sensores e capacidades 
de processamento que precisam ser acessados de forma otimizada para que a experiência seja fluida e 
convincente. Historicamente, isso levou à criação de frameworks específicos para cada plataforma dominante, 
como o ARKit para dispositivos Apple e o ARCore para o ecossistema Android.

O Dilema do Desenvolvedor: Se você deseja que sua aplicação de RA alcance o maior número possível 
de usuários, precisa considerar ambas as plataformas. Isso pode significar manter duas bases de código 
separadas, aprender duas APIs distintas e, consequentemente, dobrar o esforço de desenvolvimento e 
manutenção.

Embora tanto o ARKit quanto o ARCore sejam ferramentas robustas e poderosas, eles representam um dilema para 
os desenvolvedores. É como ter que aprender dois idiomas diferentes para se comunicar com pessoas que falam o 
mesmo tipo de mensagem, mas em dialetos distintos.

É nesse ponto que o AR Foundation da Unity entra em cena, oferecendo uma promessa de simplificação e 
unificação. Ele não substitui o ARKit ou o ARCore, mas atua como um tradutor universal, uma camada intermediária 
que permite que seu código Unity "fale" com ambos os frameworks de forma transparente. Ao invés de se 
preocupar com as especificidades de cada plataforma, você pode focar na lógica da sua aplicação e na 
experiência do usuário, deixando que o AR Foundation cuide da comunicação com o hardware subjacente. Essa 
abstração é fundamental para acelerar o desenvolvimento e permitir que mais criadores explorem o potencial da 
RA.



O Que é AR Foundation? Simplificando o 
Desenvolvimento Multiplataforma
O AR Foundation é um pacote de software desenvolvido pela Unity Technologies, projetado para ser a espinha 
dorsal do desenvolvimento de Realidade Aumentada dentro do motor Unity. Em sua essência, ele é uma API 
(Application Programming Interface) unificada que oferece um conjunto comum de funcionalidades para interagir 
com as capacidades de RA dos dispositivos, independentemente de estarem rodando ARKit (iOS) ou ARCore 
(Android). Pense nele como um controle remoto universal para suas experiências de RA. Você aperta o mesmo 
botão para "ligar" a detecção de planos, e o AR Foundation traduz esse comando para o idioma correto do ARKit 
ou do ARCore, conforme a plataforma.

Escreva Uma Vez
Código único para ambas as 
plataformas

Tradução Automática
AR Foundation comunica com 
ARKit e ARCore

Foco na Experiência
Menos tempo com código, mais 
com inovação

Essa abstração é o grande trunfo do AR Foundation. Ao invés de escrever código específico para detectar planos 
no iOS e depois reescrever para o Android, você escreve uma única vez usando os componentes do AR 
Foundation. Ele se encarrega de "conversar" com o framework nativo (ARKit ou ARCore) em tempo de execução, 
garantindo que sua aplicação funcione de forma consistente em ambos os ecossistemas. Isso não apenas 
economiza tempo e recursos, mas também reduz a curva de aprendizado para desenvolvedores que desejam criar 
experiências de RA abrangentes.

A relevância do AR Foundation cresce exponencialmente com a ascensão da Computação Espacial. Dispositivos 
como o Apple Vision Pro, que representam a próxima geração de interação digital, dependem de uma 
compreensão robusta do ambiente. O AR Foundation, ao unificar as bases de detecção e rastreamento, prepara os 
desenvolvedores para criar aplicações que transcendem as telas de celular, pavimentando o caminho para 
ambientes verdadeiramente imersivos. Ele permite que você se concentre na inovação e na criação de 
experiências significativas, em vez de se perder nas complexidades de cada plataforma.



A Arquitetura por Trás da Magia: 
Subsistemas do AR Foundation
Para entender como o AR Foundation consegue unificar o desenvolvimento de RA, é crucial mergulhar em sua 
arquitetura modular, que é construída em torno do conceito de subsistemas. Imagine que você está montando um 
carro. Você não precisa construir cada peça do zero; em vez disso, você usa módulos especializados, como o 
sistema de freios, o sistema de motor e o sistema elétrico. Cada um desses módulos é um "subsistema" que 
executa uma função específica e bem definida.

O Que São Subsistemas?

No contexto do AR Foundation, os subsistemas são componentes de baixo nível que encapsulam funcionalidades 
específicas de RA, como detecção de planos, rastreamento de movimento, estimativa de luz, e assim por diante. 
Cada subsistema é uma interface genérica que o AR Foundation expõe, e por trás dessa interface, ele carrega a 
implementação específica do ARKit ou do ARCore, dependendo do dispositivo em que a aplicação está rodando. 
Isso significa que, para o desenvolvedor, a forma de interagir com a detecção de planos é sempre a mesma, 
mesmo que as "engrenagens" por baixo sejam diferentes em um iPhone e em um Samsung Galaxy.

Detecção de Planos
Identifica superfícies horizontais e verticais no 
ambiente

Rastreamento de Movimento
Monitora a posição e orientação do dispositivo

Estimativa de Luz
Analisa as condições de iluminação do ambiente

Ancoragem
Fixa objetos virtuais em pontos do mundo real

Essa abordagem modular é incrivelmente poderosa porque permite que o AR Foundation seja flexível e extensível. 
Se uma nova capacidade de RA surgir no futuro, ou se um novo framework de RA for lançado, a Unity pode criar 
um novo subsistema ou atualizar um existente sem quebrar o restante da sua aplicação. É uma arquitetura que 
garante compatibilidade e prepara seu projeto para o futuro, alinhando-se com os avanços contínuos em SLAM 
(Simultaneous Localization and Mapping) e compreensão de cena que tornam o rastreamento de ambiente cada 
vez mais estável e rápido.



Gerenciadores: Orquestrando os 
Subsistemas
Se os subsistemas são as "peças" especializadas que realizam as tarefas de RA, os gerenciadores (ou Managers) 
são os componentes Unity que nos permitem interagir com essas peças de forma prática e intuitiva. Pense nos 
gerenciadores como os painéis de controle ou os botões que você usa para operar os subsistemas do seu "carro 
de RA". Enquanto os subsistemas trabalham nos bastidores, os gerenciadores são os pontos de contato que você, 
como desenvolvedor, adiciona aos seus GameObjects na cena Unity para ativar e configurar as funcionalidades de 
RA.

Subsistemas
Trabalham em baixo nível

Comunicam com ARKit/ARCore

Invisíveis para o desenvolvedor

Executam tarefas específicas

Gerenciadores
Interface de alto nível

Componentes Unity visíveis

Adicionados aos GameObjects

Expõem eventos e propriedades

Por exemplo, para detectar planos no ambiente real, você não interage diretamente com o subsistema de detecção 
de planos. Em vez disso, você adiciona um componente ARPlaneManager a um GameObject na sua cena. Este 
gerenciador, por sua vez, se comunica com o subsistema de detecção de planos subjacente (seja ARKit ou 
ARCore) e expõe eventos e propriedades que você pode usar para reagir a planos detectados, como criar objetos 
virtuais sobre eles. Da mesma forma, para gerenciar objetos virtuais ancorados no mundo real, você usaria um 
ARAnchorManager.

Exemplo Prático: ARPlaneManager ³ Subsistema de Detecção de Planos ³ ARKit/ARCore ³ Planos 
Detectados ³ Eventos Expostos ao Desenvolvedor

Essa separação clara entre subsistemas (a lógica de baixo nível) e gerenciadores (a interface de alto nível) é um 
pilar da usabilidade do AR Foundation. Ela permite que você trabalhe com conceitos familiares do Unity, como 
componentes e GameObjects, enquanto o AR Foundation lida com a complexidade da comunicação 
multiplataforma. É uma abordagem que simplifica o desenvolvimento, tornando-o mais acessível e produtivo, e 
permite que você se concentre em construir a experiência de RA, sabendo que a infraestrutura está sendo 
gerenciada de forma eficiente.



Os Pilares de Toda Aplicação AR: AR Session 
e AR Session Origin
Antes que qualquer mágica de Realidade Aumentada possa acontecer em seu aplicativo, precisamos estabelecer 
os fundamentos, os pilares que sustentam toda a experiência. No AR Foundation, esses pilares são o AR Session e 
o AR Session Origin. Eles são os primeiros GameObjects que você adicionará à sua cena Unity para iniciar a 
jornada da RA, e entender suas funções é crucial para construir qualquer aplicação.

AR Session
O motor da sua aplicação de RA

Gerencia o ciclo de vida da sessão

Inicia, pausa e para a RA

Comunica com ARKit/ARCore

Habilita rastreamento do ambiente

AR Session Origin
O sistema de coordenadas da RA

Define o ponto de referência (0,0,0)

Pai de todos os objetos de RA

Contém a AR Camera

Permite posicionamento preciso

O AR Session é o componente central que gerencia o ciclo de vida da sua experiência de RA. Pense nele como o 
"motor" da sua aplicação de RA. Ele é responsável por iniciar, pausar e parar a sessão de RA, além de gerenciar a 
comunicação com o framework de RA nativo do dispositivo (ARKit ou ARCore). Quando você inicia uma sessão de 
RA, o AR Session informa ao dispositivo que ele deve começar a rastrear o ambiente, a detectar superfícies e a 
fornecer dados de pose. Sem um AR Session ativo, nenhuma funcionalidade de RA será habilitada, e seu aplicativo 
não conseguirá "ver" o mundo real.

Complementando o AR Session, temos o AR Session Origin. Este GameObject é o que estabelece o sistema de 
coordenadas para todo o conteúdo de RA na sua cena. Imagine que você está em uma sala e precisa definir um 
ponto de referência para colocar móveis virtuais. O AR Session Origin faz exatamente isso: ele define onde está o 
"zero, zero, zero" da sua cena Unity em relação ao mundo real. Ele também é o pai de todos os objetos de RA que 
você colocará na cena, incluindo a câmera de RA. Ao mover o AR Session Origin, você move todo o conteúdo 
virtual em relação ao mundo real, o que é fundamental para o rastreamento e o posicionamento precisos.



A Janela para o Mundo Real: AR Camera
Com o AR Session e o AR Session Origin estabelecidos, precisamos de uma forma de visualizar o mundo real e 
sobrepor nosso conteúdo virtual de maneira convincente. É aqui que entra a AR Camera, um componente 
especializado que atua como a "janela" da sua aplicação para o ambiente físico. Diferente de uma câmera Unity 
padrão, a AR Camera é projetada especificamente para Realidade Aumentada, incorporando funcionalidades 
essenciais para uma experiência imersiva.

Funções Principais da AR Camera

01

Renderização do Feed de 
Vídeo
Captura e exibe o mundo real em 
tempo real através da câmera física 
do dispositivo

02

Rastreamento de Posição
Trabalha com subsistemas para 
entender a posição e orientação do 
dispositivo no espaço

03

Alinhamento Virtual-Real
Aplica transformações de 
perspectiva para que objetos virtuais 
se alinhem perfeitamente com o 
mundo físico

A principal função da AR Camera é renderizar o feed de vídeo ao vivo do mundo real, que é capturado pela câmera 
física do dispositivo. Mas ela vai além de uma simples transmissão de vídeo. A AR Camera trabalha em conjunto 
com os subsistemas de rastreamento do AR Foundation (e, por extensão, do ARKit ou ARCore) para entender a 
posição e a orientação do dispositivo no espaço. Isso é crucial para que os objetos virtuais que você coloca na 
cena pareçam estar fixos no mundo real, mesmo quando o usuário se move. É como ter um cinegrafista inteligente 
que não apenas filma, mas também entende onde ele está e para onde está apontando, ajustando a perspectiva 
para que tudo faça sentido.

Integração com SLAM: A AR Camera se beneficia dos avanços em SLAM (Simultaneous Localization and 
Mapping), garantindo rastreamento robusto e estável, resultando em experiências de RA mais 
convincentes e menos propensas a "derrapagens" visuais.

Tecnicamente, a AR Camera é um componente que geralmente é adicionado automaticamente como filho do AR 
Session Origin quando você o cria. Ela substitui a câmera principal padrão da Unity em cenas de RA e é 
responsável por aplicar as transformações de perspectiva e projeção corretas para que o conteúdo virtual se 
alinhe perfeitamente com o mundo físico. Essa integração com os avanços em SLAM (Simultaneous Localization 
and Mapping) garante que o rastreamento seja cada vez mais robusto, permitindo que a AR Camera mantenha uma 
compreensão estável e rápida do ambiente, resultando em experiências de RA mais convincentes e menos 
propensas a "derrapagens" visuais.



Configurando um Projeto Unity do Zero: 
Primeiros Passos
Agora que entendemos os conceitos fundamentais do AR Foundation, é hora de colocar a mão na massa e 
configurar um projeto Unity do zero para uma aplicação de Realidade Aumentada básica. Este é o ponto de partida 
para qualquer desenvolvedor que deseja criar experiências imersivas, e seguir os passos corretamente garantirá 
uma base sólida para seus futuros projetos. Pense nisso como preparar o terreno antes de construir uma casa: a 
fundação precisa ser perfeita.

Passo 1: Criar Novo Projeto

O primeiro passo é criar um novo projeto Unity. Ao abrir o Unity Hub, selecione "New Project" e escolha o template 
"3D Core". Embora existam templates específicos para AR, começar com o 3D Core nos dá um controle maior 
sobre a adição dos pacotes necessários e nos ajuda a entender cada etapa do processo. Uma vez que o projeto 
esteja aberto, a próxima etapa crucial é instalar os pacotes do AR Foundation e os plugins específicos da 
plataforma.

Passo 2: Instalar Pacotes Essenciais

Para fazer isso, vá em Window > Package Manager. No Package Manager, certifique-se de que a opção "Unity 
Registry" esteja selecionada no menu suspenso no canto superior esquerdo. Procure por "AR Foundation" e 
instale-o. Em seguida, procure por "ARCore XR Plugin" e "ARKit XR Plugin" e instale ambos. Esses plugins são as 
implementações específicas que o AR Foundation usará para se comunicar com o ARCore no Android e o ARKit no 
iOS, respectivamente. Instalá-los garante que sua aplicação será verdadeiramente multiplataforma desde o início.

1 AR Foundation
Pacote principal que unifica 
as APIs de RA

2 ARCore XR Plugin
Implementação específica 
para dispositivos Android

3 ARKit XR Plugin
Implementação específica 
para dispositivos iOS



Configurando um Projeto Unity do Zero: XR 
Plug-in Management
Com os pacotes essenciais do AR Foundation e os plugins específicos de plataforma instalados, o próximo passo 
crítico é configurar o Unity para que ele saiba qual provedor de RA usar em tempo de execução. Esta etapa é 
gerenciada através do XR Plug-in Management, uma seção vital nas configurações do projeto que atua como um 
"gerenciador de drivers" para suas experiências de Realidade Estendida (XR), que inclui Realidade Aumentada e 
Realidade Virtual.

Como Configurar o XR Plug-in Management

Edit > Project Settings Selecione "XR Plug-in 
Management"

Habilite ARCore e ARKit

Para acessar essa configuração, vá em Edit > Project Settings e selecione a aba "XR Plug-in Management" no 
painel esquerdo. Aqui, você verá duas sub-abas: "Android" e "iOS". É fundamental que você configure ambas, 
mesmo que seu foco inicial seja apenas uma plataforma. Para cada aba, marque a caixa de seleção ao lado de 
"ARCore" (para Android) e "ARKit" (para iOS). Ao fazer isso, você está dizendo ao Unity para inicializar os 
provedores de RA correspondentes quando sua aplicação for executada em um dispositivo dessas plataformas.

Aba Android

7  ARCore

Habilita suporte para dispositivos Android compatíveis 
com ARCore

Aba iOS

7  ARKit

Habilita suporte para dispositivos Apple compatíveis 
com ARKit

Essa configuração é crucial porque é nela que o Unity decide qual SDK de RA subjacente será ativado. Sem 
habilitar esses plugins, mesmo com os pacotes instalados, sua aplicação não conseguirá acessar as 
funcionalidades de Realidade Aumentada do dispositivo. É como ter um carro com todas as peças, mas sem ligar a 
ignição. O XR Plug-in Management garante que a ignição esteja ligada para as plataformas que você deseja 
suportar, permitindo que o AR Foundation orquestre a comunicação com o ARKit ou ARCore de forma transparente 
e eficiente, preparando sua aplicação para o ambiente de Computação Espacial.



Criando a Cena AR Básica: Adicionando 
Componentes Essenciais
Com o projeto configurado e os pacotes instalados, estamos prontos para construir a cena Unity que abrigará 
nossa experiência de Realidade Aumentada. Esta é a parte onde começamos a dar vida à nossa aplicação, 
adicionando os GameObjects que são os pilares do AR Foundation que discutimos anteriormente. O processo é 
direto, mas cada componente tem um papel vital na forma como sua aplicação interage com o mundo real.

Checklist de Configuração da Cena

1

Remover Main Camera
Delete a câmera padrão da cena, pois ela será 
substituída pela AR Camera

2

Adicionar AR Session
Clique com botão direito no Hierarchy > XR > AR 
Session

3

Adicionar AR Session Origin
Clique com botão direito no Hierarchy > XR > AR 
Session Origin

4

Verificar AR Camera
Confirme que a AR Camera foi criada 
automaticamente como filho do AR Session Origin

Comece abrindo uma nova cena (ou usando a cena padrão). O primeiro passo é remover a Main Camera que vem 
por padrão na cena. Ela não é otimizada para RA e será substituída pela AR Camera, que é gerada 
automaticamente pelo AR Foundation. Em seguida, no painel Hierarchy, clique com o botão direito, vá em XR e 
selecione AR Session. Este GameObject será adicionado à sua cena e, como vimos, é o responsável por gerenciar 
o ciclo de vida da sua sessão de RA.

Logo após adicionar o AR Session, repita o processo: clique com o botão direito no Hierarchy, vá em XR e 
selecione AR Session Origin. Este é o GameObject que define o sistema de coordenadas da sua experiência de RA. 
Uma característica importante do AR Session Origin é que, ao ser adicionado, ele automaticamente cria um 
GameObject filho chamado AR Camera. Esta é a câmera especializada que renderizará o feed de vídeo do mundo 
real e sobreporá seu conteúdo virtual. Com esses dois GameObjects essenciais na cena, você tem a base mínima 
para uma aplicação de Realidade Aumentada funcional, pronta para interagir com o ambiente físico.

Estrutura Final da Hierarquia:
" AR Session
" AR Session Origin
  5% AR Camera



Testando a Aplicação AR Básica: O Primeiro 
Olhar
Depois de configurar o projeto, instalar os pacotes e adicionar os GameObjects essenciais à cena, é natural querer 
ver o resultado do seu trabalho. Testar a aplicação AR básica é um passo emocionante, pois é o momento em que 
você finalmente vê o mundo real através da lente da sua criação. No entanto, é importante lembrar que, para testar 
aplicações de Realidade Aumentada, você precisará de um dispositivo físico compatível (um smartphone ou tablet 
com suporte a ARKit ou ARCore), pois o modo de jogo do Unity no editor não simula o ambiente de RA.

Processo de Build e Deploy

1
File > Build Settings

2
Selecione Android ou iOS

3
Switch Platform

4
Adicione a cena atual

5
Conecte o dispositivo

6
Build And Run

Para testar, você precisará construir e implantar sua aplicação no dispositivo. Primeiro, vá em File > Build Settings. 
Selecione a plataforma "Android" ou "iOS" (dependendo do seu dispositivo de teste) e clique em "Switch Platform". 
Certifique-se de que sua cena atual esteja incluída na seção "Scenes In Build". Em seguida, conecte seu 
dispositivo ao computador e clique em "Build And Run". O Unity compilará seu projeto e o instalará no dispositivo.

O Que Esperar no Primeiro Teste

7 Sucesso

Feed de vídeo da câmera visível

AR Session iniciado corretamente

AR Session Origin ativo

AR Camera funcionando

¦  Ainda Não Implementado

Nenhum objeto virtual visível

Sem detecção de planos

Sem interação com o ambiente

Apenas visualização da câmera

Ao abrir o aplicativo no seu dispositivo, você deve ver o feed de vídeo da câmera do seu celular. Neste ponto, não 
haverá nenhum objeto virtual sendo exibido, pois ainda não adicionamos nenhum. No entanto, o fato de você ver o 
feed da câmera através do seu aplicativo Unity já é um grande indicativo de sucesso! Isso significa que o AR 
Session foi iniciado corretamente, o AR Session Origin está ativo e a AR Camera está funcionando, capturando o 
ambiente. É como acender uma lanterna em um quarto escuro: você ainda não colocou nada lá, mas já pode ver o 
espaço, confirmando que a base da sua experiência de RA está operacional. Se houver problemas, verifique as 
permissões do aplicativo no dispositivo e as versões dos pacotes no Unity.



Além do Básico: Onde o AR Foundation nos 
Leva
A configuração de um projeto AR Foundation com o AR Session, AR Session Origin e AR Camera é o ponto de 
partida, a tela em branco onde a verdadeira magia da Realidade Aumentada começa a ser pintada. Embora essa 
base seja essencial para estabelecer a conexão com o mundo real, o AR Foundation oferece um vasto leque de 
funcionalidades que permitem criar experiências muito mais ricas e interativas. É aqui que a abstração dos 
subsistemas e gerenciadores realmente brilha, permitindo que você adicione capacidades complexas com relativa 
facilidade.

Funcionalidades Avançadas do AR Foundation

Detecção de Planos
Identifica superfícies planas como pisos, mesas 
e paredes. Fundamental para ancorar objetos 
virtuais de forma realista, fazendo com que 
pareçam parte do mundo físico.

Ancoragem de Objetos
Mantém objetos virtuais fixos em pontos 
específicos do mundo real, garantindo que 
permaneçam no lugar mesmo quando o usuário 
se move.

Rastreamento de Imagens
Dispara experiências de RA quando uma 
imagem específica é reconhecida pela câmera, 
permitindo interações baseadas em marcadores 
visuais.

Rastreamento de Faces
Aplica filtros e efeitos em rostos humanos em 
tempo real, possibilitando experiências de RA 
focadas em pessoas.

Estimativa de Luz
Analisa as condições de iluminação do 
ambiente para que objetos virtuais sejam 
iluminados de forma consistente com o mundo 
real.

Oclusão
Permite que objetos reais bloqueiem objetos 
virtuais, criando uma sensação mais realista de 
profundidade e integração espacial.

A partir dessa base, você pode começar a explorar recursos como a detecção de planos. Adicionando um 
ARPlaneManager ao seu AR Session Origin, sua aplicação será capaz de identificar superfícies planas no 
ambiente, como pisos, mesas e paredes. Isso é fundamental para ancorar objetos virtuais de forma realista, 
fazendo com que eles pareçam fazer parte do mundo físico. Imagine colocar um sofá virtual na sua sala ou um 
mapa interativo sobre uma mesa 3 tudo isso começa com a detecção de planos.

Além da detecção de planos, o AR Foundation suporta uma série de outras funcionalidades avançadas: ancoragem 
de objetos (para manter objetos virtuais fixos em um ponto do mundo real), rastreamento de imagens (para 
disparar experiências de RA quando uma imagem específica é reconhecida), rastreamento de faces (para aplicar 
filtros e efeitos em rostos humanos), e até mesmo estimativa de luz (para que os objetos virtuais sejam iluminados 
de forma consistente com o ambiente real). Essas capacidades aproveitam os avanços contínuos em SLAM e 
compreensão de cena, que tornam o rastreamento de ambiente mais estável e rápido, permitindo que suas 
aplicações de RA sejam cada vez mais imersivas e responsivas.



Melhores Práticas e Considerações de 
Design para AR Foundation
Desenvolver com AR Foundation não se resume apenas a escrever código; trata-se de criar uma experiência de 
usuário fluida e intuitiva que se integra harmoniosamente com o mundo real. Assim como um arquiteto não projeta 
apenas a estrutura de um edifício, mas também pensa na funcionalidade e no conforto dos seus ocupantes, um 
desenvolvedor de RA precisa considerar as melhores práticas de design e performance para garantir que a 
aplicação seja eficaz e agradável. A era da Computação Espacial, impulsionada por dispositivos como o Apple 
Vision Pro, eleva ainda mais a importância dessas considerações, focando na imersão e na interação natural.

Performance
Aplicações de RA são exigentes em termos de processamento e bateria. Otimize seus modelos 3D, 
texturas e materiais para garantir que a aplicação rode suavemente em uma variedade de 
dispositivos. Evite cenas excessivamente complexas ou com muitos objetos em tempo real. Pense na 
sua aplicação como um atleta: ela precisa ser ágil e eficiente para ter um bom desempenho.

Feedback do Usuário
A Realidade Aumentada é uma tecnologia nova para muitos, e os usuários podem não saber como 
interagir com ela. Forneça instruções claras e visuais sobre como escanear o ambiente, detectar 
planos e posicionar objetos. Use indicadores visuais, como retículos ou animações, para guiar o 
usuário.

Consciência Ambiental
As aplicações de RA dependem de um ambiente bem iluminado e com texturas para um rastreamento 
eficaz. Informe o usuário se o ambiente não for ideal. Considere adicionar mensagens como "Procure 
uma área com boa iluminação" ou "Mova o dispositivo lentamente para escanear o ambiente".

Design Espacial
O design para a Computação Espacial vai além da tela, exigindo que pensemos em como os objetos 
virtuais se comportam e interagem no espaço tridimensional. Considere a escala, a profundidade e a 
oclusão para tornar a experiência mais imersiva e menos uma simples sobreposição.

Checklist de Otimização

Modelos 3D: Use LOD (Level of Detail) e reduza a contagem de polígonos

Texturas: Comprima texturas e use tamanhos apropriados

Materiais: Prefira shaders simples e evite transparências complexas

Iluminação: Use baked lighting quando possível

Física: Minimize o uso de física em tempo real

UI: Mantenha a interface limpa e não obstrutiva



Desafios Comuns e Como Superá-los com 
AR Foundation
Mesmo com a simplificação que o AR Foundation oferece, o desenvolvimento de Realidade Aumentada ainda 
apresenta seus próprios conjuntos de desafios. É importante estar ciente dessas armadilhas comuns para que 
você possa antecipá-las e implementar estratégias para superá-las, garantindo uma experiência de usuário mais 
robusta e confiável. Pense em um navegador experiente que conhece os recifes e as correntes traiçoeiras de um 
oceano; ele não os evita, mas sabe como contorná-los.

Principais Desafios e Soluções

Perda de Rastreamento
Problema: Dispositivo não 
consegue identificar posição 
no ambiente

Causas: Pouca luz, superfícies 
sem textura, movimentos 
rápidos

Solução: Detectar eventos de 
perda de rastreamento, 
informar o usuário, 
implementar lógica de re-
centragem

Performance em 
Dispositivos Antigos
Problema: Aplicação lenta 
ou travando em hardware 
menos potente

Causas: Modelos 
complexos, muitos objetos, 
funcionalidades pesadas

Solução: Otimizar modelos 
3D, reduzir objetos na 
cena, desativar 
funcionalidades não 
essenciais

Onboarding do Usuário
Problema: Usuários não 
sabem como usar a aplicação 
de RA

Causas: Falta de instruções, 
interface confusa, tecnologia 
nova

Solução: Criar tutorial inicial, 
fornecer feedback visual 
constante, guiar o processo de 
escaneamento

Estratégias de Mitigação

Detecção Proativa

Monitore eventos do AR 
Foundation

Verifique qualidade do 
rastreamento

Detecte condições ambientais

Comunicação Clara

Mensagens de erro amigáveis

Instruções visuais

Feedback em tempo real

Recuperação Graceful

Opções de reset da sessão

Salvamento de estado

Degradação de funcionalidades

Um dos desafios mais frequentes é a perda de rastreamento. Isso ocorre quando o dispositivo não consegue mais 
identificar sua posição e orientação no ambiente, fazendo com que os objetos virtuais "derrapem" ou 
desapareçam. Isso pode acontecer em ambientes com pouca luz, superfícies sem textura (paredes brancas lisas) 
ou movimentos muito rápidos. Para mitigar isso, o AR Foundation oferece eventos que você pode usar para 
detectar a perda de rastreamento e informar o usuário, talvez pedindo para ele escanear o ambiente novamente ou 
redefinir a sessão. Implementar uma lógica de "re-centragem" pode ser vital para a usabilidade.

Outro desafio é a performance em dispositivos mais antigos ou menos potentes. Embora o AR Foundation 
abstraia grande parte da complexidade, a capacidade de processamento do dispositivo ainda é um fator limitante. 
Nesses casos, otimizar seus modelos 3D, reduzir o número de objetos na cena e desativar funcionalidades de RA 
menos críticas (como detecção de faces, se não for essencial) pode fazer uma grande diferença. O onboarding do 
usuário também é crucial: guiar o usuário através do processo inicial de escaneamento e calibração é fundamental 
para evitar frustrações. O AR Foundation, ao fornecer uma base unificada, permite que você foque mais na lógica 
de tratamento desses desafios em nível de aplicação, em vez de se preocupar com as diferenças de 
implementação entre ARKit e ARCore.



Consolidação e Próximos Passos
Nesta aula, desvendamos o AR Foundation, a poderosa ferramenta da Unity que unifica o desenvolvimento de 
Realidade Aumentada para ARKit e ARCore. Exploramos como ele simplifica o processo através de sua arquitetura 
de subsistemas e gerenciadores, e mergulhamos nos componentes essenciais como o AR Session, AR Session 
Origin e AR Camera, que formam a espinha dorsal de qualquer aplicação de RA. Além disso, percorremos os 
passos práticos para configurar um projeto Unity do zero, desde a instalação de pacotes até a criação da cena 
básica, e discutimos as melhores práticas e desafios comuns no desenvolvimento de RA, sempre com um olhar 
nas tendências de Computação Espacial e nos avanços em SLAM.

Em Prática
Comece um novo projeto Unity, instale os pacotes AR Foundation, ARCore XR Plugin e ARKit XR Plugin 
via Package Manager. Habilite os provedores de XR Plug-in Management para Android e iOS. Remova a 
Main Camera da cena e adicione os GameObjects AR Session e AR Session Origin. Construa e teste sua 
aplicação em um dispositivo físico para ver o feed da câmera.

Autoavaliação

1

Questão 1
Qual é a principal vantagem do 
AR Foundation para 
desenvolvedores de Realidade 
Aumentada?

a) Permite criar aplicações de 
Realidade Virtual.
b) Unifica o desenvolvimento 
para ARKit e ARCore, reduzindo 
o retrabalho.
c) Substitui completamente o 
uso de Unity para 
desenvolvimento AR.
d) É exclusivo para dispositivos 
Apple Vision Pro.

2

Questão 2
Qual componente do AR 
Foundation é responsável por 
gerenciar o ciclo de vida da 
sessão de Realidade 
Aumentada?

a) AR Camera
b) AR Session Origin
c) AR Session
d) AR Plane Manager

3

Questão 3
Ao configurar um novo projeto 
Unity para AR Foundation, quais 
pacotes devem ser instalados 
via Package Manager para 
garantir compatibilidade 
multiplataforma?

a) Apenas AR Foundation.
b) AR Foundation e ARCore XR 
Plugin.
c) AR Foundation, ARCore XR 
Plugin e ARKit XR Plugin.
d) Apenas ARKit XR Plugin.

4

Questão 4
O que o "XR Plug-in Management" nas 
configurações do projeto Unity permite ao 
desenvolvedor?

a) Gerenciar os modelos 3D da cena.
b) Habilitar os provedores de Realidade Estendida 
(XR) para as plataformas desejadas.
c) Otimizar o código C# da aplicação.
d) Publicar a aplicação diretamente nas lojas de 
aplicativos.

5

Questão 5 (Dissertativa)
Explique a diferença funcional entre um 
"subsistema" e um "gerenciador" no contexto do 
AR Foundation, fornecendo um exemplo de cada.



Gabarito e Recursos Adicionais
Gabarito

Questão 1
Resposta: b)

Questão 2
Resposta: c)

Questão 3
Resposta: c)

Questão 4
Resposta: b)

Conexão com a Próxima Aula

Na próxima aula, "Aula 10 3 Detecção e Visualização de Planos", daremos um passo adiante, aprendendo a 
usar o ARPlaneManager para identificar superfícies no mundo real e como visualizar esses planos detectados, 
abrindo as portas para o posicionamento de objetos virtuais de forma interativa.

Recursos Adicionais

Documentação Oficial 
da Unity AR Foundation
Para aprofundar nos detalhes 
técnicos e exemplos de código.

Canal Unity Learn
Tutoriais em vídeo sobre AR 
Foundation para aprendizado 
prático.

Artigos sobre 
Computação Espacial
Para entender o contexto 
futuro da Realidade 
Aumentada.

NOTA IMPORTANTE: As informações regulatórias/legais/técnicas desta aula estão atualizadas até 2025. 
Consulte sempre fontes oficiais para verificar alterações.


